**Why Do We Need Color Management?**

With the transfer from film to digital imaging, we need to re-approach some of the same issues our forefathers did. Color management is one such issue. In the same way that different films and photo papers have different color characteristics, different camera sensors, computer monitors and printers have different color characteristics. At Rochester Institute of Technology, one eye was photographed on six different fundus cameras and results in six different looking images (Figure 1). Diagnostically, it could be detrimental to have the same image look different at your capture station than it does on your review station. Many examination room computers and computer monitors are not designed for image viewing, and color shifts on the examination room monitor may mask the pathology you saw so clearly on your capture station monitor. As scientific and diagnostic imagers we should take a scientific and diagnostic approach to this problem by learning about color management and applying it to ophthalmic photography.

**What is Color Management?**

In order to understand color management we need to first understand color. What is color? There are a multitude of answers to this question. Two common answers are a specific wavelength of light or a visual perception. Scientifically speaking, color is a specific wavelength of light, but we certainly don’t walk around describing our new car as being ‘candy apple 625nm’. Thinking of light as a visual perception opens us to the idea that not everyone has the same perception. What affects how we perceive color?

There are three main factors that go into the color equation: a light source, an object and the observer. Changes in any of these three things could change the outcome of our color equation. Different light sources have different colors, for example, tungsten light appears yellow; fluorescent lights appear green; and strobe light appears bluish. The object in the color equation, and how it reacts to light, plays a role as well. A good example of the same object interacting with light and resulting in different outcomes can be found in some of our favorite 1980’s fashion statements, specifically the puffy taffeta dress. Thinking back to those glorious days of pretty in pink you may recall that depending on the angle of light on taffeta, it appears different colors, though we know it is all dyed the same color. The last factor in our color equation is the observer. Something we are all familiar with is an angiogram patient saying that everything looks red after having photos taken. The patient’s perception is that neutral seems red due to the color after effect phenomenon. As the photographer, you haven’t had the same experience of seeing bright flashes of blue-green light so your perception is different.

Part of understanding color also involves defining and describing color. The analog graphic design world uses Pantone color chips as a standard. In the digital world we can go through a similar process by using predetermined color values. Computers quantify every color they display into very specific numerical values. We can use these specific values to manipulate colors and create a color-managed workflow. Each digital device is capable of reproducing specific colors; this group of colors is referred to as the device’s color space or gamut. As you can see in Figure 2, the range of colors visible to the human eye is the largest color space. From there we lose colors as we go from device to device. Our cameras aren’t capable of capturing all the colors our eyes can see, and our monitors and software programs might not be able to display all the colors that our camera captured. Our printers have a very small set of colors they are capable of reproducing. The question that lies before us isn’t how we can make our printer reproduce the col-
ors seen by the camera, as much as how we can create an accurate and realistic end product. The idea of a color-managed workflow is to move your image from one device to another device with a different color space without it negatively affecting the image.

The first step in creating a color-managed workflow is to identify all the devices, or color spaces, we will be using. We will also need to track how each of these devices interacts with color and what variables might affect this interaction. Devices can generally be divided into input devices, processing devices, and output devices. Common input devices are scanners and digital cameras. Variables that can affect the image at the input stage are changes in lighting systems, exposure, and even camera settings such as ISO or resolution. Processing devices include imaging editing software such as Adobe® Photoshop®. We need to recognize that not all image editing software is the same. Most image editing software has a proprietary way of dealing with color and running a color managed workflow. We need to make sure we understand the differences between programs before switching to new software. Any device that is a final destination for your image is considered an output device. This includes monitors, printers and even projectors. Many things can change the color equation at the output stage such as changes in viewing light, different types of monitors, different types of printers, even different inks or photo papers. Knowing and keeping all of these variables consistent is imperative in finding a color managed workflow solution.

The most common color management solution is using International Color Consortium (ICC) profiles. ICC profiles use a device’s color space and relate it to a universal color space or a profile connection space. The most commonly used profile connection space (PCS) is CIE LAB (International Commission on Illumination, L for lightness and a and b for the color-opponent dimensions). This color space is based on human color perception and is a mathematical model that describes a color on three levels: lightness of color, position between green and magenta, and position between yellow and blue. The ICC profile is simply a table that maps a device’s color space to the PCS. Using the PCS as a universal translator allows us to move images from one device's color space to another device's color space. We will need a profile for each device in our workflow to ensure everyone is ‘speaking the same language’. The profiles for each device are used by a color management module (CMM) that is located within your operating system or software program. When given an input profile and an output profile the CMM translates one color space to the next. The CMM also specifies what should be done when colors in the input profile simply don’t exist in our output profile. A color that our output device cannot reproduce is referred to as out of gamut. There are four options, or rendering intents, that can be used to deal with these out of gamut colors: perceptual, relative, absolute or saturation. The most commonly used rendering intent for
photographic images is perceptual. This rendering intent will compress the input color space until it fits inside the output color space, which preserves color relationships. Perceptual rendering intent is a good choice for keeping images realistic when there are a significant amount of out of gamut colors and it will help images avoid ‘stair-stepping’ in the middle of a gradient. The other commonly used rendering intent is relative colorimetric. This rendering intent maps white of the input color space to the white of the output color space and then will reproduce in-gamut colors exactly. Out of gamut colors will be shifted to the next available color in the output color space. This option is the most accurate, however it can result in stair stepping in areas of gradient. Since we are looking for pathology and changes from the norm fundus photographs, having color relationships preserved is probably more useful than having the exact color represented.

Now that we have a better understanding of color, color space, and ICC profiles, we are ready to apply what we know to color fundus photography and create a step by step color-managed workflow. Step one is to identify devices we need to profile for fundus photography. In most cases this will be a camera, a monitor and a printer.

**The Camera: Perhaps Our Biggest Challenge**

Every camera sensor manufacturer has a different idea of what correct color looks like. The manufacturer will optimize the color space their sensor is capable of reproducing. For us this means that the same eye photographed on different sensors can result in very different images. The solution for this in the commercial photography world involves creating an ICC profile using a color checker that has known numerical values, such as the one in Figure 3. A photo is taken of the color checker under all the same conditions that will be used for future photos. This color checker photo needs to have the same light source, the same flash power, the same f-stop, and the same ISO as all future photos taken. Profiling software will then measure the numerical values the camera captured for the color checker and compare it to the known numerical values of the color checker. Given this information, the profiling software will create an input profile. This method is less than ideal for fundus photography, for a variety of reasons. Using the eye’s optics during fundus photography means that any media changes will affect our image. This means that we, technically, would need to build a profile for each and every eye we photograph. We would even need to re-create a profile for repeat patients since media opacities can progress. Perhaps the largest obstacle we encounter when trying to apply this solution is that we cannot put a color checker inside the eye.

What now? We need to do something to create consistency and we certainly don’t want to give up. Talk to your vendor. Ask if the images are tagged with a profile, meaning that a profile is already created and being included with the image file. Ask them to recommend a color profile to use with their images. Since we are just starting out on this venture into color management for ophthalmic imaging you may not get a quick and easy answer, but bringing the problem to the vendor’s attention is important. There are a few other options we have. If your fundus camera uses a consumer digital SLR, find out what the manufacturer recommends. We can also experiment and try different profiles in the workflow to see what works best. Two of the most common profiles are Adobe RGB 1998 and sRGB. Finally, if you are not happy with the results from the experiment and check method, you could mimic the general conditions present inside the eye and photograph a color checker under those conditions. This means you would want to have a dark room and will need a pocket sized color checker.

**The Monitor: The Easiest Piece of the Puzzle**

The best way to get consistent color managed results from the monitor is to both calibrate and profile. Calibration is the process of setting the monitor’s white point and black point, adjusting the brightness and contrast for optimum viewing, and setting the lighting condition or color temperature. You will want to choose the lighting temperature that best matches the conditions under which your monitor is used. Some monitors will have these listed by type: daylight, fluorescent, or tungsten. Others will list color temperature in degrees Kelvin (K). For most of us, that means fluorescent (ranging from 3200-7500K) or tungsten lighting (ranging from 2500-29000K). You should be able to easily find the color temperature in degrees Kelvin on the light bulb’s packaging. You may also be asked to choose a gamma setting. PC computers should ideally use a gamma of 2.2 and Mac computers should use a gamma of 1.8. Most operating systems have basic monitor calibration tools built in and high-end monitors often come with software and guides for calibrating your monitor. You can check your computer and monitor user guides to see what tools are available for your system. Using these tools is better than
doing nothing, but if you are truly looking for a color
managed workflow you also need to profile your moni-
tor. A good profiling software package will include moni-
tor calibration as the first step in creating the profile.

Profiling the monitor is the process of using a device,
often a colorimeter or spectrophotometer, to measure
resulting color output when the monitor is asked to dis-
play a specific color. The profiling software will display a
set of colors as the device takes measurements, then cre-
ate the monitor profile based on this data. Once the pro-
file is created, most profiling software will also help you
save the profile and make it the default monitor profile.

Recently the two foremost companies in digital
color management, Xrite and GretagMacbeth, joined
forces. They have a range of professional and prosumer
products for monitor calibration, specifically the EyeOne
Display package that includes a colorimeter and software
to both calibrate and profile your monitor. ColorVision’s
Spyder offers similar monitor profiling packages.

You will need to re-profile your monitor on a regular
basis. Exactly how often depends on your needs. Older
monitors usually need to be recalibrated and profiled
more often than newer monitors. If you need very pre-
cise color matching, for example at a reading center or
university that does a lot of imaging for publication, you
would want to calibrate and profile more often. In gener-
al, it is a good idea to recalibrate and profile the monitor
every few weeks. It is also very important to determine
your optimum viewing conditions.

**Monitor Viewing Standards**

Having your monitor set for optimum viewing is just
as crucial as having it calibrated and profiled, perhaps
more so, since poor viewing conditions can make any
well calibrated and profiled monitor look bad. There are
currently no standards for viewing diagnostic fundus pho-
tographs on a monitor, or in ‘soft copy’. There are stan-
dard viewing conditions for digital imaging production
facilities set in place by the International Organization for
Standardization (ISO), and there is some research found
on the subject of viewing ‘soft copy’ radiology images
on consumer grade monitors. If we consult the digital
imaging and publishing industry, we will find that they
recommend a dimly lit room with no overhead lighting
or other lighting that falls directly on the monitor. The
ideal conditions for digital image editing for publication
would be a room with no windows with all walls and
ceilings painted a neutral grey. They also suggest that
any lighting used is D50 (5000 degrees Kelvin) or D65
(6500 degrees Kelvin). In fundus photography we cer-
tainly aren’t trying to match colors the way the photo
and publishing industry is, but we could adopt some
of their standards to our practice. It is easy to see how
glare and direct ambient lighting on the screen can nega-
tively affect the image, but does this mean that the best
thing to do is turn off the ambient lighting altogether?
An article in the *American Journal of Roentgenology* found
that “Typical office lighting …can reduce diagnostic effi-
cacy compared with lower levels of ambient lighting. If,
however, no light other than that of the monitor is used,
results are similar to those with excessive levels of light-
ing.”1 Although research hasn’t been conducted on the
effects of ambient lighting during diagnostic reading of
fundus photo soft copy images, it makes sense that we
could find similar results as were found in publishing and
radiology.

A loose set of recommendations for viewing fundus
photos from a computer monitor includes:

- No ambient light directly falling on the monitor itself.
- Low ambient light levels, only slightly brighter ambient
  light than the screen itself creates.
- Daylight balanced lighting when possible, D50 or D65.

Consistency and standardization is key in any work-
flow and the same is true for the lighting conditions
used for viewing images. By adopting standard viewing
conditions for your practice, and comparing or suggesting
these standard viewing conditions to other sites you col-
laborate with, perhaps we will soon see an industry wide
standard emerge.

**The Printer: Last But Not Least.**

Profiling the printer is very similar to profiling the moni-
tor. Profiling software will come with a digital target
sheet of color patches with known input values. This will
be printed without any color management from your
printer driver or image editing software. Once the print
is dry a device is used to measure the color patches and
this measurement data is used to create a profile that can
be used to make consistent color prints. This profile is
customized for the specific printer, ink, paper and print
settings used to make the target color patch print. Keep
in mind that changing any of these variables could make
the profile ineffective.

There are many different companies who provide
printer profiling packages, varying from less expensive
prosumer packages to more costly professional print pro-
duction packages. Xrite, GretagMacbeth and ColorVision
all have a range of products to help with printer profiling
and many of these products also include monitor profil-
ing as part of the package.

Unlike monitor profiling, the printer does not need
to be re-profiled until one of the variables changes.
Unfortunately, these changes could be something as
miniscule as a new formulation of ink or photo paper.
Usually these changes are not drastic enough to warrant
recreating a printer profile, but if color printing problems
arise and there seems no obvious reason for the prob-
lem, it might be easiest to start troubleshooting by recre-
ating the profile.

Once everything is profiled we are ready to move
on to step two: using the profiles. Input and monitor
profiles require little work to implement in everyday use. The input or camera profile chosen is used every time and should be embedded or tagged to each image file. When creating the monitor profile, the last step is usually making this profile the default monitor profile and this should not need to be adjusted. You will, however, need to ensure you are using optimum viewing settings as detailed in the section above on monitor profiling. Utilizing printer profiles can be a bit more difficult. We’re going to look at using printer profiles in Adobe Photoshop CS3, a widely used image editing software.

**USING PROFILES IN PHOTOSHOP**

Be sure you start with a file that has an embedded or tagged profile. Using an un-tagged file could result in unexplained color shifts. Always preview your image using a soft proof to ensure that what you see on screen is a close approximation of what you will see on the print. A soft proof will basically preview the image in the color space of the printer. To see the soft proof go to View > Proof Setup > Custom. From the custom menu you will choose the printer profile you created and also choose the rendering intent you want to use (Figure 4).

It is also a good idea to view the gamut warning to see which colors are being changed. Sometimes a simple decrease in saturation can pull these colors back into gamut. To see the out of gamut colors go to View > Gamut Warning.

If you are satisfied with the result of your soft proof you are ready to print. Go to File > Print. Under the color management section you should have the color handling set to “Photoshop manages color” and rendering is set to “perceptual”.

Looking ahead at the challenges that lay before us in digital fundus photography can be daunting, especially when it comes to color management. We are in somewhat uncharted territory as most printers, inks, papers and profiling software packages are optimized for general use. While the general public prints images that include purples and electric blues, we are usually printing monochrome images or images that are heavily biased towards reds. Perhaps as digital ophthalmic imaging advances, we will begin to see manufacturers creating solutions specifically for medical or even ophthalmic use. The best way to encourage these changes is to make sure our manufacturers realize the need for a solution. If there is enough demand, surely we will see the industry try to supply a solution. In the meantime, there are great tools available that can be used to reduce some of our digital color imaging headaches and help to create more consistent results, not only between examination lanes but also between different facilities.

**COLOR MANAGEMENT IDEAS IN BRIEF**

- **CONTROL** as much as you can to eliminate as many variables as possible. Adopt a standard workflow from start to finish. Adopt standard monitor viewing conditions.
- **CALIBRATE** Monitors. Calibration includes setting appropriate white point and brightness controls.
- **PROFILE** what you can: scanners, monitors, and printers.
- **ADVOCATE** consistency in practice and manufacture. As users we need to advocate the need for color consistency from our vendors and colleagues.

**REFERENCES**


**FURTHER TECHNICAL READING**

*Real World Color Management* by Bruce Fraser, Chris Murphy and Fred Bunting, Peachpit Press; Second Edition (September 8, 2004) ISBN: 0321267222

International Color Consortium, www.color.org

International Organization for Standardization, www.iso.org